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Microsoft PowerPoint 
Enter Dates  

Instructor Information 

Instructor  Email  Office Location & Hours  
add text add text  add text 

General Information  

Description 
The Microsoft PowerPoint course is designed to elevate your proficiency and expertise in utilizing Microsoft 
PowerPoint, the industry-standard presentation software. This comprehensive course will equip you with the 
essential skills to navigate the PowerPoint interface seamlessly, work with slides, apply formatting, and 
harness an array of features to enhance presentations with charts, videos, and animations. 
 
Throughout the course, you will delve into vital topics, including incorporating multimedia, and utilizing 
advanced slide design techniques. You will also learn to animate presentations to captivate your audience, 
ensure seamless collaboration with team members, and leverage features like Presenter View for delivering 
persuasive presentations. 
 
Successful completion of the certification exam validates the knowledge and skill sets of individuals seeking 
employment or advancement in their careers.  
  
Course Objectives 
This course teaches the skills you will need to successfully complete the Microsoft PowerPoint certification 
offered by Certiport. These skill sets are introduced using multiple types of exercises and review materials. 

After completing this course, you will understand the following:  

 Master the Microsoft PowerPoint interface and explore its extensive features 

 Develop and design presentations with professional formatting and styles 

 Manage and organize slides for optimal flow and audience engagement 

 Incorporate dynamic content such as charts, tables, and SmartArt graphics 

 Integrate multimedia elements like audio and video seamlessly into your presentations 

 Employ animations and transitions to add a layer of polish and sophistication 

 Utilize collaboration tools for team-based presentation development 

 Execute presentations using advanced tools like Presenter View and dynamic slide features 

Expectations and Goals  
Upon completion of this course, learners are expected to complete the Microsoft PowerPoint Certification 
Exam. Certification candidates will demonstrate the fundamentals of creating and managing worksheets 
and workbooks, creating cells and ranges, creating tables, applying formulas and functions and creating 
charts and objects. To learn more about the Microsoft Office Specialist program visit: Microsoft Office 
Specialist :: Certiport (pearsonvue.com) 
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Certifications provide significant advantages to professional and job candidates. These include: 

• Higher grade point average for certified high school students 

• Higher graduation rates for certified high school students 

• Increased post-secondary enrollment 

• Reduced dropout rates 

Additional information: The value of certification 

Course Materials  

Required materials  
 XperienceED account 

 Computing Device 

 Internet Connection 

Optional materials  
 Headset 

Schedule  

Dates Unit  

 Unit 1: Getting Started 

 Unit 2: Working with Text 

 Unit 3: Working with Slides 

 Unit 4: Inserting Objects 

 Unit 5: Enhancing Presentations 

 Unit 6: Preparing the Slide Show 

Course Structure 

The course is structured to learn by doing, practice the learned skill, then apply the skills. 

• Unit 
• Lesson 

 Learn Tasks 
 Practice Exercises 
 Practice Questions 

• Objective Assessment 
• Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where you can learn through doing 
or learn through study materials (eBook, QuickDeck or QuickClip). Each lesson concludes with a Practice 
Exercise that incorporates the tasks you have learned throughout the lesson. Once you have completed the 
lessons in the unit, you are assessed through a question-based Objective Assessment and a Create Project. 
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Weights and Grading 

Add your course weight and grading here 

Additional information and resources  

Add a subheading  
Add text. 

 

4



Instructor Guide 
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Overview 
Course Structure 
The course is structured to learn by doing, practice the learned skill, and then apply the skills. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can 
understand through doing or learning through study materials (eBook, QuickDeck or QuickClip). 
Each lesson concludes with a Practice Exercise that incorporates the tasks they learned 
throughout the lesson. Once they have completed the lessons in the unit, learners are assessed 
through a question-based Objective Assessment and a Create Project. 

Delivery 
The course is created so it can be customized to meet the needs of the instructor and the learner.  

• Direct Instruction:  Utilize the PowerPoints Presentations to introduce each lesson topic, 
then have the learners review the study materials and complete the task. 

• Flipped  Classroom:  Learners complete online lessons outside of class time. Learners 
utilize the class time to discuss learned tasks, allow learners to teach concepts, expand 
concepts through learning stations, and work on unit extension or unplugged activities. 

• Learner-Centered Approach: Use the prescriptive learning model so learners can focus 
on new skills and skip the skills they already know. Learners can work at their own pace on 
their own schedule to complete the course. Instructors support learners by utilizing the 
answer keys to identify struggles and guide learners through the solutions.   

Differentiation 
• Study Materials: Study materials are available in eBook, QuickDeck and QuickClip format. 

Each study material provides the same concepts and allows the learners to choose the 
modality that best fits their learning style. The eBook introduces concepts in bite-sized 
readings. QuickDecks display materials in a flashcard format. QuickClips provide a video 
and audio-based clip. 
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• Course Progression: Learners can complete the learn task to demonstrate understanding 
before reviewing the study materials or they can review one or all the study materials 
before attempting the learn tasks. 

• Grouping: Create groups for different learning levels or styles. Customize each group 
setting to best meet the needs of the learners. 

• Provide struggling learners with answer keys to follow step-by-step instructions to 
complete tasks and exercises. 

• Encourage learners to showcase their newly learned skills by creating additional real-world 
projects, teach others how and why to use new skills, and explore beyond their learning. 

Prepare for Delivery 
• Begin with the unit overview to understand the structure and flow of the unit, the topics 

covered, the approximate time to complete and the exam objectives reviewed. 

• Review the lesson PowerPoint Presentation to give you an in-depth look at each lesson 
topic and the comprehensive topic notes included. 

• Review the answer keys to familiarize yourself with the tasks learners will complete 
throughout the lesson. 

• Complete the lesson. 

Instructor Resources Overview 
Instructor 
Resources 
File Structure 

 Instructor Resources  
 Course Syllabus 
 Course Overview 
 Course Key Terms 
 Course Instructor Guide 
 Unit 

 Unit Assessment Answer Keys 
 Create Project 
 Objective Assessment  

 Lesson 
 Answer Keys 

 Lesson Practice Exercises 
 Learn Tasks 
 Lesson Practice Questions 

 Study Guides 
 Study Guide Complete 
 Study Guide Fill-In Explanation 
 Study Guide Fill-In Topic 

 Lesson PowerPoint Presentations 
 Unplugged Activities 
 Unit Overview 
 Unit Learning Plan 

7



 Unit Key Terms 
Unit Assessment 
Answer Keys 

Each unit includes two types of assessments for learners to apply their 
knowledge. 

• Create Project – These are project prompts and sample solution 
files. Create projects also include “show me” videos for learner 
reference. You have the option to enable/disable this feature. 

• Objective Assessment – A comprehensive question and answer-
based assessment for the unit. Objective Assessments include 
“show solution” for learner reference. You have the option to 
enable/disable this feature. 

Answer Keys 
 

Documents containing answers, step-by-step instructions, and correct 
answers for Instructor reference or to offer additional support material for 
learners. 

• Learn Tasks - Each lesson topic includes an opportunity to apply 
what they have just learned in-app or by answering questions. Learn 
Tasks also include “show me” videos and “show solution” for learner 
reference. 

• Lesson Practice Exercises – End of lesson in-app or scenario-based 
assessment. Lesson Practice Exercises also include “show me” 
videos for learner reference. You have the option to enable/disable 
this feature. 

• Lesson Practice Questions – End of lesson question-based 
assessment. Lesson Practice Questions also include “show solution” 
for learner reference. You have the option to enable/disable this 
feature. 

Study Guides Printable and customizable study guides mapped to lesson topics and 
exam objectives are provided in three formats. 

• Complete- This version includes the topic and the explanation. 
• Fill-In Topic-Learners can fill in the topics as they learn or as a 

review. 
• Fill-In Explanation – This allows learners to complete the 

explanation of each lesson topic in their own words and images. 
Learning Plan Customizable unit learning plan outlining the objectives and topics 

covered, essential questions, learning targets, methods and materials, 
extension activities, formative and summative assessments, mapping to 
STEAM, Work Readiness, 5 C’s, and Bloom’s Taxonomy Levels.  

Lesson 
PowerPoint 

A PowerPoint Presentation that complements the lesson. Each lesson topic 
is included in the presentation as well as comprehensive speaker notes. 

Unplugged 
Activities 

A variety of activities and necessary resources to get learners off the 
computers while still reinforcing unit learning objectives. 

Unit Key Terms A comprehensive list of key terms throughout the unit. 
Unit Overview A spreadsheet containing the overview of the flow of the unit that includes 

lesson topics, certification objectives mapping, and approximate timings for 
self-paced and instructor-led scenarios. 
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PowerPoint Learning Plan 

Unit 1: Getting Started 
Instructor: Class: Duration: 5-9 hours 
Unit Objectives:  
Learners will be proficient in navigating the PowerPoint application, customize settings to suit their preferences, and 
confidently utilize the various tools and features available for creating and delivering effective presentations. 

Essential Questions: 
• What is Microsoft PowerPoint, and why is it an important tool for presentations? 
• How do you save, export, and share your PowerPoint presentations effectively and securely? 
• What are the different views available in PowerPoint, and how can they help you during the presentation 

creation process? 

Learning Targets: 
I will learn how to effectively format text and utilize text tools in PowerPoint presentations so I can create visually 
appealing slides that engage my audience.  
I will practice adjusting font styles, sizes, colors, and effects to highlight key information and maintain consistency.  
I will know I succeeded when I can confidently apply various text formatting techniques to enhance the overall 
impact and clarity of my presentation content. 

Methods and Materials: 
• Lectures 
• Reading 
• Videos 
• Hands-on activities 
• Creating 
• Analyzing  
• Discussing 
• Teaching 

Formative Assessments: 
• Learn Tasks 
• Practice Questions 
• Practice Exercises 

Summative Assessments: 
• Objective Assessment 
• Create Project 

STEAM 
☐ Science 
☒ Technology 
☒ Engineering 
☒ Art 
☐ Math 

Work Readiness 
☒ Communication 
☒ Problem-solving 
☒ Teamwork 
☒ Work ethic 
☒ Empathy 
☒ Conflict resolution 
☒ Active listening 
☒ Time management 
☒ Adaptability 
☒ Reading 
☒ Mathematics 

5 C’s 
☒ Critical Thinking 
☒ Creativity 
☒ Communication 
☒ Collaboration 
☒ Citizenship 

Blooms Level 
☒ Remembering 
☒ Understanding 
☒ Applying  
☒ Analyzing 
☒ Evaluating  
☒ Creating 
 

 

Learning Activities 
Lesson Time Allowed Content 

Introduction to 
PowerPoint 

60-130 minutes • PowerPoint Overview 
• PowerPoint Window 
• Ribbon 
• Ribbon Tabs 
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• Customize Ribbon 
• Developer Tab 
• Quick Access Toolbar 
• Navigation Pane 

Basic Concepts 85-205 minutes • Create a New Presentation 
• Open a Presentation 
• Save a Presentation 
• Change a Template 
• Save a Template 
• Save a Presentation as a PDF 
• Save a Presentation as Images 
• Save a Presentation as a Video 
• Print a Presentation 
• Print Layout Options 
• Print Handouts 
• Print Color 

Settings 55-115 minutes • Presentation Properties 
• Set as Read-Only 
• Password Protect 
• Mark as Final 
• Compatibility 
• Inspect a Presentation 

 

Warm-Up Activities 
1. Discuss and compare the common features and functionalities shared between Microsoft Word and 

PowerPoint, highlighting how these features are utilized differently in each application. 
2. Reflect on your prior experience with PowerPoint presentations and share one or more instances when 

you used PowerPoint, whether for school, work, or personal projects. Describe the purpose of those 
presentations and any challenges or successes you encountered. 

3. List and explain three different formats in which you can save a PowerPoint presentation. For each format, 
provide a real-life scenario or example of when you would choose to save a presentation in that particular 
format. Consider factors like sharing, editing, and compatibility in your explanations. 

Extension Activities 
1. Create a portfolio for the course. Portfolios should include evidence of work, reflect on learned skills and 

how you can incorporate the skills in a current or future project. This is an ongoing extension activity. 
Continue to add to the portfolio throughout the course. 

2. Select one topic learned throughout the unit then create an instructional video, tutorial, lecture, or hands 
on activity to teach others about the skill. 

3. Analyze a well-designed PowerPoint presentation that you find online or in your course materials. Identify 
what makes it effective in terms of layout, visuals, text, and slide transitions. Create a brief report explaining 
the elements that contribute to its success. 

4. Explore the customization options for the PowerPoint window. Change the color scheme, background, or 
other elements to personalize your PowerPoint environment. Share what you customized and explain why 
you made those changes. 

5. Create a new Ribbon tab for a specific theme or topic (e.g., 'Research' tab for academic presentations). 
Decide which groups and commands to include and present the rationale for your choices. 
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Unit Evaluation and Reflection 
What went well What needs to change 
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Unit 1 Introduction to PowerPoint Learn Tasks 
OD 
# 

OD 
Desc 

Lesson 
Topic 

Assessment Details Answer Key File 
Name 

  PowerPoint 
Overview 

Why is PowerPoint a helpful tool 
for creating presentations? 
a) It helps you write essays 

faster. 
a) It allows you to share 

information in a clear and 
interesting way. (correct) 

b) It adds random images to 
your slides automatically. 

c) It removes all videos and 
pictures from your 
presentation. 

 
Fill in the blank with the correct 
word.  
PowerPoint allows you to use 
pictures, charts, and __________ to 
make your presentation more fun 
and quickly understood. 
• videos 
• essays 
• homework 
• bookmarks 
 
You should add as many pictures 
and videos as possible to every 
slide to make your presentation 
have an exciting appearance. 
• True 
• False  
 

a) It helps you write essays faster. 
b) It allows you to share 

information in a clear and 
interesting way. (correct) 

c) It adds random images to your 
slides automatically. 

d) It removes all videos and 
pictures from your 
presentation. 

Explanation: PowerPoint helps you 
organize and present information 
clearly and visually. 
 
 
PowerPoint allows you to use 
pictures, charts, and videos 
(correct) to make your 
presentation more fun and quickly 
understood. 
Explanation: Videos can help 
explain topics better and keep your 
audience engaged. 
 
 
• True 
• False (correct) 
Explanation: Adding too many 
pictures or videos can make your 
slides crowded and confusing. Use 
them only when they help your 
message. 

 

  PowerPoint 
Window 

Identify: 
• File Tab  
• Status bar 
• Ribbon 
• Slide Pane 
• View Buttons 

 
 

 

  Ribbon Match the following terms: 
a) Galleries 
b) Ribbon 
c) Dialog Box Launcher 
d) Contextual Tabs 
 
_____ is located at the top of the 
window and contains tabs, 
groups, and commands to help 
you build your presentation. 
_____ appear when you select 
specific objects like pictures or 
charts and offer additional tools. 
_____ display visual style options, 
such as Themes, in a preview 

Ribbon (correct) is located at the 
top of the window and contains 
tabs, groups, and commands to 
help you build your presentation. 
Contextual Tabs (correct) appear 
when you select specific objects 
like pictures or charts and offer 
additional tools. 
Galleries (correct) display visual 
style options, such as Themes, in a 
preview format so you can view 
the effect before applying it. 
Dialog Box Launcher (correct) 
opens a window with more 

 

 

 
 

Status 
Bar 

File 
Tab 

Ribbon 
View 
Buttons 
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OD 
# 

OD 
Desc 

Lesson 
Topic 

Assessment Details Answer Key File 
Name 

format so you can view the effect 
before applying it. 
_____ opens a window with more 
advanced settings and controls 
for certain commands. 

advanced settings and controls for 
certain commands. 

  Ribbon Tabs Review the following terms and 
descriptions and match the 
terms to correctly identify when 
you would use the Ribbon tabs. 
a) Design 
b) Insert 
c) Review 
d) Animations 
_____  Helps you make your slides 
look nice by picking different 
colors and designs. 
_____  Helps you make objects on 
your slides move, like showing 
text or moving images. 
_____  Helps you add pictures, 
shapes, charts, and more to your 
slides. 
_____  Helps you check spelling, 
leave comments, and make 
changes. 

Design (correct) – Helps you make 
your slides look nice by picking 
different colors and designs. 
Animations (correct) – Helps you 
make objects on your slides move, 
like showing text or moving 
images. 
Insert (correct) – Helps you add 
pictures, shapes, charts, and more 
to your slides. 
Review (correct) – Helps you 
check spelling, leave comments, 
and make changes. 
 

 

  Customize 
Ribbon 

Place the steps into the correct 
order to successfully customize 
the Ribbon in PowerPoint. 
1) In the PowerPoint Options 

dialog box, select the 
Customize Ribbon option. 

2) Choose the tab where you 
want to add or remove a tool 
from the right column. 

3) Open PowerPoint and go to 
the File tab at the top left 
corner of the window. 

4) In the menu that appears, 
choose Options. 

5) Use the Add or Remove 
button between the two 
columns to make changes. 

6) Select the OK button to save 
your changes. 

 

1) Open PowerPoint and go to 
the File tab at the top left 
corner of the window. 
(correct) 

2) In the menu that appears, 
choose Options. (correct) 

3) In the PowerPoint Options 
dialog box, select the 
Customize Ribbon option. 
(correct) 

4) Choose the tab where you 
want to add or remove a tool 
from the right column. 
(correct) 

5) Use the Add or Remove 
button between the two 
columns to make changes. 
(correct) 

6) Select the OK button to save 
your changes. (correct) 

Explanation: Great job! Following 
these steps will help you 
personalize your PowerPoint 
interface for more efficient work. 

 

  Developer 
Tab 

Why would you enable the 
Developer tab in PowerPoint? 
a) To change the theme of your 

presentation 
b) To access tools for adding 

interactive buttons, forms, 
and special commands  

c) To insert pictures and videos 

a) To change the theme of your 
presentation 

b) To access tools for adding 
interactive buttons, forms, 
and special commands 
(correct) 

c) To insert pictures and videos 
d) To apply transitions between 

slides 
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OD 
# 

OD 
Desc 

Lesson 
Topic 

Assessment Details Answer Key File 
Name 

d) To apply transitions between 
slides 

 
 

Explanation: The Developer tab 
provides access to advanced tools 
like buttons, forms, and custom 
commands. 

  Quick 
Access 
Toolbar 

What is the main benefit of 
customizing the Quick Access 
Toolbar in PowerPoint? 
a) It changes the background 

color of your slides. 
b) It allows you to add 

animations quickly. 
c) It gives you quick access to 

commands you use most 
often.  

d) It adds new design themes to 
your presentation. 

 
 
You can remove commands from 
the Quick Access Toolbar if you 
don’t use them. 
• True  
• False 
 

a) It changes the background 
color of your slides. 

b) It allows you to add animations 
quickly. 

c) It gives you quick access to 
commands you use most 
often. (correct) 

d) It adds new design themes to 
your presentation. 

Explanation: Customizing the 
Quick Access Toolbar helps you 
save time by adding frequently 
used commands. 
 
• True (correct) 
• False 
Explanation: The Quick Access 
Toolbar is customizable, and you 
can remove any command you 
don’t need. 

 

  Navigation 
Pane 

If the Navigation bar is not 
displayed make sure you are in 
the normal view. 
• True  
• False 

• True (correct) 
• False 
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Unit 1 Introduction to PowerPoint 
Practice Exercise 
 

Assessment Details Answer Key File Name 

1) Add a section name “Final” 
before the summary slide. 

2) Add the “New Slide” option to 
the Quick Access Toolbar. 

3) Add a new slide after the final 
slide from the Quick Access 
Toolbar. 

 

1) File Tab > Open > This PC > 
Geometric Color Block file 

2) Home Tab > Slides Group > 
Section > Add Section > “Final.” 

3) File Tab > Options > Quick Access 
Toolbar > Choose Commands 
from: “New Slide” > Quick Access 
Toolbar: “New Slide.” 

4) Quick Access Toolbar > “New 
Slide” 
OR 
Ctrl + M 

Geometric Color 
Block.pptx 
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Unit 1 Introduction to PowerPoint 
Practice Questions 
 

 
1) The title Bar is located at the bottom of the window. 

• True 
• False (correct) 

 
2) Review the following terms and descriptions and match the terms to correctly identify when 

you would use the Ribbon tabs. 

a) Galleries 
b) Groups 
c) Contextual Tabs 

 
Galleries (correct) – It has similar commands to help you with different tasks. 
Groups (correct) – It has different visual options and styles. 
Contextual Tabs (correct) – It has special tools just for working with pictures or charts. 
 

3) Match the following words into the correct category. 

a) Design 
b) Themes 
c) Draw 
d) Stencils 

 
Ribbon Tabs Non-Ribbon Tabs 

Design (correct) Themes (correct) 
Draw (correct) Stencils (correct) 

 
4) Which of the following is not an option inside the Ribbon? 

a) Merge 
b) Slide Master 
c) Add Table (correct) 
d) Record 

 
5) Which of the following is not a group inside the Developer Tab? 

a) Code 
b) Comments (correct) 
c) Add-ins 
d) Controls 

 
6) The Quick Access Toolbar is great because it saves you time. Instead of looking for commands 

in different places, you can have them organized in one spot.  

• True (correct) 
• False 

 
7) The Navigation Pane in PowerPoint is a helpful tool that helps you move around and organize 

your slides.  

• True (correct) 
• False 
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Introduction to 
PowerPoint

Unit 1: Getting Started
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PowerPoint Overview 

• Presentation software
• Include pictures, charts, 

videos, special effects
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PowerPoint Window 

• Ribbon like other 
Microsoft Office 
programs

• Contains additional 
features
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Ribbon

• Contextual tabs – Pictures and charts
• Groups – Task buttons
• Galleries – Themes, options, styles
• Dialog box launcher – More options
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Ribbon Tabs 

• Each tab has different tools to create and customize a 
presentation

• Includes Home, Draw, Design etc.
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Customize Ribbon 

File > Options > 
PowerPoint Options 
dialog box > 
Customize Ribbon
option 
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Developer Tab 

• Special commands, interactive buttons, forms, advanced 
programming tools

• File tab > Options > Customize Ribbon > Developer
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Quick Access Toolbar 

• Top left corner of window
• Save and Undo
• Customizable

25



Navigation Pane 

• View tab > 
Presentation Views 
group > Normal

• Thumbnail preview 
of slides
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Unit 1 Introduction to PowerPoint 
Study Guide Complete  

Topic   Explanation   
PowerPoint Overview 
PowerPoint Create and share presentations. 

Benefits • Share information in a concise way. 
• Presentations are organized and creative. 
• Integrate images, charts, videos, and special effects.  

Slides Individual pages in a presentation. 

Overview Tip • Use pictures and videos widely. 
• Avoid overcrowding slides. 
• Practice your presentation before presenting it to others. 

PowerPoint Window 
PowerPoint Window Contains the Ribbon interface of other Microsoft Office programs. 

Quick Access Toolbar  Provides quick access to frequently used commands. 

Ribbon Interface at the top of the window with tabs and groups for accessing 
commands and tools. 

Title Bar  Displays the name of the open presentation. 

Min/Restore/Max/Close 
Buttons  

Control the size and closure of the PowerPoint application window. 

Slide Navigation Pane  Displays thumbnail views of each slide for organization and 
navigation. 

Slide Pane  Main workspace for viewing and editing the selected slide. 

Split Bar  Adjusts the size of the Slide Navigation or Outline View pane. 

Status Bar  Displays presentation information and includes buttons for Notes 
and viewing options. 

View Buttons Allows switching between different views of the presentation. 

Zoom Slider  Adjusts the zoom level of slides in the presentation. 

Ribbon 
Ribbon Tool at the top of the PowerPoint window with tabs for accessing 

different commands and tools. 
Contextual Tabs  Tabs that appear when working with specific objects like pictures or 

charts, offering tools specific to those tasks. 
Groups Organized sections within the Ribbon that contain related 

commands for performing different tasks. 
Galleries Visual displays of options or styles, allowing users to choose from 

different designs or formats. 
Dialog Box Launcher  Special button in the Ribbon that opens a dialog box with advanced 

options and controls for a specific command. 
Ribbon Elements  Tabs, contextual tabs, groups, dialog box launcher, and galleries 

within the Ribbon interface. 
Themes Designs that can be applied to the entire presentation, accessed 

through the gallery in the Design tab. 
Dialog Boxes  Windows that provide additional options and controls for specific 

commands, accessed through the dialog box launcher. 
Ribbon Tabs 
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Home Tab with tools for changing the appearance of text and slides, 
including fonts and colors. 

Insert Adding pictures, shapes, charts, and other elements to slides. 

Draw Drawing items on slides and converting them to text or shapes. 

Design Enhancing the visual appeal of slides by selecting colors and designs. 

Transitions Adding special effects when transitioning from one slide to another. 

Animations Making objects on slides move, such as text or images. 

Slide Show  Starting and controlling the presentation slideshow. 

Review Checking and editing the presentation, including spelling checks, 
comments, and changes. 

View Displaying slides in different formats, such as list or full screen, and 
for zooming in or out. 

Format (Contextual)  Tab that appears when specific elements, like pictures, are selected, 
providing options to modify their appearance. 

Customize Ribbon 
Customize Ribbon  Process of personalizing the Ribbon in PowerPoint for maximum 

efficiency by adding or removing frequently used tools. 
Steps to Customize Ribbon 1. Go to File tab at the top left corner of the window.  

2. In the menu that appears, choose Options. This will open the 
PowerPoint Options dialog box.  

3. In the PowerPoint Options dialog box, select the Customize 
Ribbon option on the left side. 

4. There are two main columns: one for the tabs;  another for  tools 
within each tab. 

Steps to Customize Ribbon 
 

5. Select the tab where you want to add it from the list on the right 
side.  

6. Choose the specific tool you want to add or remove from the left 
side. Use the Add button between the two columns to add it. 

7. Select the OK button to save your changes. 
Developer Tab 
Developer Tab  Provides additional tools for creating interactive and unique 

presentations. 
Steps to Turn on Developer 
Tab 

1. On the File tab > Options > Customize Ribbon. 
2. In the Customize Ribbon Section select Developer by putting a 

checkmark next to it. 
3. Select OK to save your changes. 

Benefits • Make and edit special commands. 
• Add interactive buttons and forms.  
• Add more advanced programming tools. 

Quick Access Toolbar 
Quick Access Toolbar (QAT) Toolbar located above the Ribbon, providing quick access to 

commonly used commands. 
Benefits • Saves time and enhances efficiency. 

• Organize commands in one spot. 
• Customizable. 

Steps to Customize the QAT 1. Right-Click on the Quick Access Toolbar at the top left corner of 
the window – a window will appear. 

2. Choose commands to add to the toolbar. 
3. If the command you want is not in the menu, select More 

Commands at the bottom. This will open a new window called 
PowerPoint Options.  
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4. Find the Quick Access Toolbar section in the PowerPoint Options 
window.  

Steps to Customize the QAT 5. There are two lists: one with the commands currently on the 
toolbar and another with commands you can add.  

6. To add a command, choose it from the list on the left then select 
Add button in the middle. It will be added to the toolbar.  

7. To remove a command, select it from the list on the right and then 
Remove button in the middle.  

8. You can also change the order of the commands by using the 
arrows on the right side.  

9. Select OK to save your changes. 
Navigation Pane 
Navigation Pane  Tool located on the left side of the PowerPoint window, displaying 

thumbnail images of slides. 
Benefits • Navigate and organize slides. 

• Thumbnail images and search maintain efficiency and 
organization. 

Thumbnail Images  Small previews of each slide's content illustrated in the Navigation 
Pane  

Steps to Use the Navigation 
Pane 

1. Locate the Navigation Pane on the left side of the window. 
2. If the Navigation bar is not displayed make sure you are in the 

normal view by going to the View tab > Presentation Views group 
> Normal. 

3. Scroll through the list in the Navigation Pane and find the slide 
you want to view or edit.  

Steps to Use the Navigation 
Pane 
 

4. Select its thumbnail image to make it the active slide. The active 
slide will be displayed in the main slide area of the PowerPoint 
window.   

5. Rearrange the order of the slides by selecting and dragging a 
slide's thumbnail image to a new position in the list. 

Active Slide  Slide that is currently selected and displayed in the main slide area of 
the PowerPoint window. 

Normal View  View that displays the Navigation Pane on the left side of the 
window. 
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Unit 1 Introduction to PowerPoint 
Study Guide Fill-In Explanation 

Topic   Explanation   
PowerPoint Overview 
PowerPoint  

Benefits  

Slides  

Overview Tip  

PowerPoint Window 
PowerPoint Window  

Quick Access Toolbar   

Ribbon  

Title Bar   

Min/Restore/Max/Close 
Buttons  

 

Slide Navigation Pane   

Slide Pane   

Split Bar   

Status Bar   

View Buttons  

Zoom Slider   

Ribbon 
Ribbon  

Contextual Tabs   

Groups  

Galleries  

Dialog Box Launcher   

Ribbon Elements   

Themes  

Dialog Boxes   

Ribbon Tabs 
Home  

Insert  

Draw  

Design  

Transitions  

Animations  

Slide Show   

Review  

View  
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Format (Contextual)   

Customize Ribbon 
Customize Ribbon   

Steps to Customize Ribbon  

Steps to Customize Ribbon  

Developer Tab 
Developer Tab   

Steps to Turn on Developer 
Tab 

 

Benefits  

Quick Access Toolbar 
Quick Access Toolbar (QAT)  

Benefits  

Steps to Customize the QAT  

Steps to Customize the QAT  

Navigation Pane 
Navigation Pane   

Benefits  

Thumbnail images   

Steps to Use the Navigation 
Pane 

 

Steps to Use the Navigation 
Pane 

 

Active Slide   

Normal View   
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Unit 1 Introduction to PowerPoint 
Study Guide Fill-In Topic  

Topic   Explanation   
PowerPoint Overview 
 Create and share presentations. 

 • Share information in a concise way. 
• Presentations are organized and creative. 
• Integrate images, charts, videos, and special effects.  

 Individual pages in a presentation. 

 • Use pictures and videos widely. 
• Avoid overcrowding slides. 
• Practice your presentation before presenting it to others. 

PowerPoint Window 
 Contains the Ribbon interface of other Microsoft Office programs. 

 Provides quick access to frequently used commands. 

 Interface at the top of the window with tabs and groups for accessing 
commands and tools. 

 Displays the name of the open presentation. 

 Control the size and closure of the PowerPoint application window. 
 Displays thumbnail views of each slide for organization and 

navigation. 
 Main workspace for viewing and editing the selected slide. 

 Adjusts the size of the Slide Navigation or Outline View pane. 

 Displays presentation information and includes buttons for Notes 
and viewing options. 

 Allows switching between different views of the presentation. 

 Adjusts the zoom level of slides in the presentation. 

Ribbon 
 Tool at the top of the PowerPoint window with tabs for accessing 

different commands and tools. 
 Tabs that appear when working with specific objects like pictures or 

charts, offering tools specific to those tasks. 
 Organized sections within the Ribbon that contain related 

commands for performing different tasks. 
 Visual displays of options or styles, allowing users to choose from 

different designs or formats. 
 Special button in the Ribbon that opens a dialog box with advanced 

options and controls for a specific command. 
 Tabs, contextual tabs, groups, dialog box launcher, and galleries 

within the Ribbon interface. 
 Designs that can be applied to the entire presentation, accessed 

through the gallery in the Design tab. 
 Windows that provide additional options and controls for specific 

commands, accessed through the dialog box launcher. 
Ribbon Tabs 
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 Tab with tools for changing the appearance of text and slides, 
including fonts and colors. 

 Adding pictures, shapes, charts, and other elements to slides. 

 Drawing items on slides and converting them to text or shapes. 

 Enhancing the visual appeal of slides by selecting colors and designs. 

 Adding special effects when transitioning from one slide to another. 

 Making objects on slides move, such as text or images. 

 Starting and controlling the presentation slideshow. 

 Checking and editing the presentation, including spelling checks, 
comments, and changes. 

 Displaying slides in different formats, such as list or full screen, and 
for zooming in or out. 

 Tab that appears when specific elements, like pictures, are selected, 
providing options to modify their appearance. 

Customize Ribbon 
 Process of personalizing the Ribbon in PowerPoint for maximum 

efficiency by adding or removing frequently used tools. 
 1. Go to File tab at the top left corner of the window.  

2. In the menu that appears, choose Options. This will open the 
PowerPoint Options dialog box.  

3. In the PowerPoint Options dialog box, select the Customize 
Ribbon option on the left side. 

4. There are two main columns: one for the tabs;  another for  tools 
within each tab. 

 5. Select the tab where you want to add it from the list on the right 
side.  

6. Choose the specific tool you want to add or remove from the left 
side. Use the Add button between the two columns to add it. 

7. Select the OK button to save your changes. 
Developer Tab 
 Provides additional tools for creating interactive and unique 

presentations. 
 1. On the File tab > Options > Customize Ribbon. 

2. In the Customize Ribbon Section select Developer by putting a 
checkmark next to it. 

3. Select OK to save your changes. 
 • Make and edit special commands. 

• Add interactive buttons and forms.  
• Add more advanced programming tools. 

Quick Access Toolbar 
 Toolbar located above the Ribbon, providing quick access to 

commonly used commands. 
 • Saves time and enhances efficiency. 

• Organize commands in one spot. 
• Customizable. 

 1. Right-Click on the Quick Access Toolbar at the top left corner of 
the window – a window will appear. 

2. Choose commands to add to the toolbar. 
3. If the command you want is not in the menu, select More 

Commands at the bottom. This will open a new window called 
PowerPoint Options.  
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4. Find the Quick Access Toolbar section in the PowerPoint Options 
window.  

 5. There are two lists: one with the commands currently on the 
toolbar and another with commands you can add.  

6. To add a command, choose it from the list on the left then select 
Add button in the middle. It will be added to the toolbar.  

7. To remove a command, select it from the list on the right and then 
Remove button in the middle.  

8. You can also change the order of the commands by using the 
arrows on the right side.  

9. Select OK to save your changes. 
Navigation Pane 
 Tool located on the left side of the PowerPoint window, displaying 

thumbnail images of slides. 
 • Navigate and organize slides. 

• Thumbnail images and search maintain efficiency and 
organization. 

 Small previews of each slide's content illustrated in the Navigation 
Pane  

 1. Locate the Navigation Pane on the left side of the window. 
2. If the Navigation bar is not displayed make sure you are in the 

normal view by going to the View tab > Presentation Views group 
> Normal. 

3. Scroll through the list in the Navigation Pane and find the slide 
you want to view or edit.  

 4. Select its thumbnail image to make it the active slide. The active 
slide will be displayed in the main slide area of the PowerPoint 
window.   

5. Rearrange the order of the slides by selecting and dragging a 
slide's thumbnail image to a new position in the list. 

 Slide that is currently selected and displayed in the main slide area of 
the PowerPoint window. 

 View that displays the Navigation Pane on the left side of the 
window. 

 

34



Unit 1: Create Project  
The Create project is designed to allow the application and demonstration of new knowledge, 
skills, and personal creativity to produce a project-based result while integrating rubric 
requirements using a checklist. 

Tip: While working on your project, remember to save your progress regularly. This will allow you 
to come back to it later. To continue working, open the document, then launch the platform 
using the Add-in whenever you're ready. 

To begin, review the Project Specifications. 

Project Specifications: Develop a structured PowerPoint presentation to introduce yourself to 
your instructor. Use the following guide/checklist to create the PowerPoint. 

Required:  

� Add at least five slides with text 
� Check for Compatibility 
� Inspect the Presentation 
� Presentation Properties 
� Set the Presentation Properties 
� Set the Presentation to Print Notes Pages or Handouts 
� Set the presentation as Read-Only or Mark as Final 
� Password Protect 

Practice: 

� Customizing the Ribbon 
� Customizing the Quick Access Toolbar 
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Unit 1: Objective Assessment  
 
1) PowerPoint helps you organize your information, like using bullet points or numbers to 

illustrate important facts. 

• True (correct) 
• False  

 
2) The title Bar is located at the bottom of the window. 

• True 
• False (correct) 

 
3) Which of the following options helps you fix/adjust the size of slide navigation or outline view 

pane? 

a) Title Bar 
b) Split Bar (correct) 
c) Status Bar 
d) Slide Pane 

 
4) Review the following terms and descriptions and match the terms to correctly identify when 

you would use the Ribbon tabs. 

• Galleries 
• Groups 
• Contextual Tabs 

 
Galleries (correct) It has similar commands to help you with different tasks. 
Groups (correct) It has different visual options and styles.  
Contextual Tab (correct) It has special tools just for working with pictures or charts. 

 
5) Match the following words into the correct category. 

a) Design 
b) Illustrations 
c) Draw 
d) Images  

Ribbon Tabs Non-Ribbon Tabs 
Design (correct) Illustrations (correct) 
Draw (correct) Images (correct) 
 

6) Which of the following tabs helps with “checking and editing your presentation”? 

a) View 
b) Review (correct) 
c) Developer 
d) Design 

 
7) Which of the following is not an option inside the Ribbon? 

a) Merge 
b) Slide Master 
c) Add Table (correct) 
d) Record 
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8) Which of the following is not a group inside the Developer Tab? 

a) Code 
b) Comments (correct) 
c) Add-ins 
d) Controls 

 
9) The Developer Tab is a default option in the Ribbon. 

• True 
• False (correct) 

 
10) The Quick Access Toolbar is great because it saves you time. Instead of searching for 

commands in different places, you can have them organized in one spot.  

• True (correct) 
• False 

 
11) The Navigation Pane in PowerPoint is a helpful tool that helps you move around and organize 

your slides.  

• True (correct) 
• False 

 
12) A thumbnail image of the first slide can give you a preview of how the slides will appear with 

that particular theme or template. 

• True (correct) 
• False 

 
13) It is not possible to open the PowerPoint files shared with the user. 

• True 
• False (correct) 

 
14) What is the shortcut key used to save the PowerPoint file? 

a) Ctrl + A 
b) Ctrl + S (correct) 
c) Ctrl + D 
d) Ctrl + O 

 
15) The Save option is located in which of the following tabs? 

a) Home 
b) File (correct) 
c) Insert 
d) View 

 
16) Which of the following tabs has the themes group/option?  

a) Draw 
b) Review 
c) Design (correct) 
d) View 
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17) Which of the following is a file extension for the PowerPoint Template File? 

a) .pptx 
b) .pptm 
c) .potx (correct) 
d) .potm 

 
18) It is possible to save the select number of slides when saving the PPT as a PDF file. 

• True (correct) 
• False 

 
19) Which of the following is a publishing option when saving the PPT as a PDF file? 

a) Outline View (correct) 
b) Videos 
c) Images 
d) URLs 

 
20) Match the following words into the correct category. 

a) WMV 
a) PNG 
b) MP3 
c) JPEG  

 
Non-Image Formats Image Formats 

WMV (correct) JPEG (correct) 
MP3 (correct) PNG (correct) 

 
21) Which of the following formats helps you save the PPT file as a video file? 

a) MP3 
b) MP5 
c) MP7 
d) MP4 (correct) 

 
22) It is possible to print custom slides from a PPT. 

• True (correct) 
• False 

 
23) Which of the following is not an option in the Print Layout Options? 

a) Full Page Slides 
b) Comments (correct) 
c) Notes Pages 
d) Outline 

 
24) Outline View includes slide titles and text to help you focus on the main points and structure.  

• True (correct) 
• False  
 

25) Printing handouts in PowerPoint allows you to make copies of your presentation with a single 
slide on each page. 

• True 
• False (correct) 
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26) Printing in grayscale is helpful when saving ink or printing documents that don't need colors.  

• True (correct) 
• False 

 
27) Which of the following is not an option inside the “Advanced Properties” Dialog Box? 

a) Custom 
b) Summary 
c) Numbers (correct) 
d) Contents 

 
28) Match the following words into the correct category. 

a) Subject 
b) Categories 
c) Print 
d) Share  

 
Non-Properties Elements Properties Elements 

Print (correct) Subject (correct) 
Share (correct) Categories (correct) 

 
29) Setting a presentation as read-only is helpful when you want to keep the content the same.  

• True (correct) 
• False 

 
30) Which of the following tabs has the Password Protect option? 

a) Password 
b) Privacy 
c) Protect 
d) File (correct) 

 
31) When you mark a presentation as final, you declare it as finished and ready for others to view.  

• True (correct) 
• False 

 
32) If there are compatibility issues in the new PPT, then there might be issues when it is opened 

in an older PowerPoint Version. 

• True (correct) 
• False 

 
33) Which of the following is not an option inside Document Inspector? 

a) Comments 
b) Tags (correct) 
c) Ink 
d) Embedded Documents 
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PowerPoint Unit 1 Key Terms 
Term Definition 

Compatibility Ensure your presentation works well on different devices and software 
versions. 

Contextual Tabs Tabs that appear in the Ribbon when certain objects or elements, such as 
images or charts, are selected.  

Developer Tab A specialized tab in PowerPoint that provides advanced tools and features 
for creating interactive and customized presentations. 

Dialog Box 
Launcher 

A small icon or button within a group in the Ribbon, represented by a small 
arrow or ellipsis. 

Galleries Visual displays within the Ribbon that present different options or styles in 
a graphical format. 

Groups Within each Ribbon tab, groups are clusters of related commands and 
tools that serve a specific function or purpose. 

Handouts Make copies of your presentation with several slides on each page to 
distribute to others. 

JPEG Joint Photographic Experts Group, a standard image file format 
commonly used for photographs and realistic images. 

Min/Restore/ 
Max/Close Buttons 

These buttons control the size and closure of the PowerPoint application 
window. 

Navigation Pane A pane located on the left side of the PowerPoint window that displays a 
list of thumbnail images representing the slides in a presentation. 

PDF Portable Document Format, a file format commonly used for sharing and 
distributing documents, including presentations. 

PNG Portable Network Graphics, a common image file format that supports 
lossless compression. 

PowerPoint A computer program that helps you make presentations. 

Quick Access 
Toolbar 

Positioned above or below the Ribbon, it offers quick access to frequently 
used commands, and you can customize it to add or remove commands 
according to your preference. 

Read-only Use this feature to share presentations with others to view only and not 
make changes in the file. 

Ribbon The main interface in PowerPoint that provides access to commands 
categorized into groups for clear navigation and execution. 
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Ribbon Tab The interface at the top of the window that includes tabs and groups to 
organize a range of commands and tools, serving as the main control 
center to access different features and functions within the application. 

Slide Navigation 
Pane 

It displays thumbnail views of each slide, helping you organize and 
navigate through slides in your presentation. 

Slide Pane This is the main workspace where you view and edit the selected slide. 

Split Bar By dragging this bar left or right, you can adjust the size of the Slide 
Navigation or Outline View pane. 

Status Bar It shows presentation information, such as the current slide number and 
total number of slides, and includes buttons for Notes and various viewing 
options. 

Template A pre-designed and formatted file that serves as a starting point for 
creating new presentations. 

Theme A predefined set of design elements and formatting styles that determine 
the overall appearance and visual consistency of a presentation.  

Title Bar Located at the top of the window, it displays the name of the open 
presentation. 

View Buttons These buttons allow you to switch between different views of your 
presentation, such as Normal, Slide Sorter, Reading, and Slide Show. 

Zoom Slider Positioned on the status bar, it enables you to adjust the zoom level of your 
slides, either by using the minus and plus buttons or by dragging the slider. 

 

 

41



Unit 1: Unplugged Activities 
Instructor Guide 
 

Instructions 
Below are a variety of offline activities to choose from to support learning in the unit. Choose activities 
to enhance learning in the classroom.  

Activity 1: Word Search 
Distribute pages 2-4 to the learners. 

With Words - Use this word search to reinforce the key terms in the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 

Activity 2: Crossword Puzzle 
Distribute pages 2-3 to the learners.  

Have learners solve the crossword puzzle by reading clues and filling in the answer with key terms 
from the unit. 

An answer key is provided. 

Activity 3: Presenting Properties Sorting 
The object of this activity is to help learners understand and categorize different presentation 
properties in PowerPoint. 

Activity 4: Ribbon Tab Sequencing 
The object of this activity is to help learners understand the organization of Ribbon Tabs in PowerPoint. 
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Unit 1: Unplugged Activity 
 

Activity 1: Word Search   

With Words - Use this word search to reinforce the key terms in the unit An answer key is provided.  

With Clues – Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 
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Unit 1 Word Search with Words 
Complete the following word search by finding and circling all the words in the box below the puzzle. 
Words can be in any direction.  

 

CONTEXTUAL 
DEVELOPER 
HANDOUTS 

NAVIGATION 
RIBBONTAB 
STATUSBAR 

GALLERIES 
READONLY 
SLIDEPANE 
SPLITBAR 
TEMPLATE 
TITLEBAR 

 

COMPATIBILITY 
DIALOGBOXLAUNCHER 

POWERPOINT 
QUICKACCESSTOOLBAR 

VIEWBUTTONS 
ZOOMSLIDER 

GROUPS 
JPEG 
PDF 
PNG 

THEME 

Q Y N D I A L O G B O X L A U N C H E R Z
M O G S D T N A V I G A T I O N B B T D X
V O K Z X W I O G T R L Y O C A T G M K Y
K Q Y J R A X L O A E X J I T K S T V L G
T Z G A L L E R I E S W P N I B R G N W A
V S O S Q E F S K Y E R O I X A J O O C O
D P N O S S T K P I S B Y M B Q D L J A I
I B O N M U U R N N B T S S S A D K D D W
O L F W O S D K O I I Y U B E G R O U P S
W E D D E O L T R L E T V R W C C V N C L
O H N B Y R T I I B A Z O O Q Y J Q Q Q T
D A Z V C U P B D T P P E T O J P E G J E
H T N J B T I O S E F S C E I U W Q P T M
Z L J W S T Q R I G R B L Z Q T R T D H P
F X E F A X A R P N G U T I T Y L Z F E L
K I P P L B R H E H T N P Q D B Z E L M A
V N M J T W W C D E V E L O P E R M B E T
L O G I I H D V E C S T D B Y U P I F A E
C J L M M F E R F C O N T E X T U A L K R
W P G Y O S O K Z M Y Z C U V M V W N H R
S Q U I C K A C C E S S T O O L B A R E E
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Unit 1 Word Search Solution Key 

 
 

 

 

  

Q Y N D I A L O G B O X L A U N C H E R Z
M O G S D T N A V I G A T I O N B B T D X
V O K Z X W I O G T R L Y O C A T G M K Y
K Q Y J R A X L O A E X J I T K S T V L G
T Z G A L L E R I E S W P N I B R G N W A
V S O S Q E F S K Y E R O I X A J O O C O
D P N O S S T K P I S B Y M B Q D L J A I
I B O N M U U R N N B T S S S A D K D D W
O L F W O S D K O I I Y U B E G R O U P S
W E D D E O L T R L E T V R W C C V N C L
O H N B Y R T I I B A Z O O Q Y J Q Q Q T
D A Z V C U P B D T P P E T O J P E G J E
H T N J B T I O S E F S C E I U W Q P T M
Z L J W S T Q R I G R B L Z Q T R T D H P
F X E F A X A R P N G U T I T Y L Z F E L
K I P P L B R H E H T N P Q D B Z E L M A
V N M J T W W C D E V E L O P E R M B E T
L O G I I H D V E C S T D B Y U P I F A E
C J L M M F E R F C O N T E X T U A L K R
W P G Y O S O K Z M Y Z C U V M V W N H R
S Q U I C K A C C E S S T O O L B A R E E
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Unit 1 Word Search with Clues 
Complete the following word search by finding and circling the words that fit the clues below. Words 
can be in any direction.  

 

 
 
 

Q Y N D I A L O G B O X L A U N C H E R Z
M O G S D T N A V I G A T I O N B B T D X
V O K Z X W I O G T R L Y O C A T G M K Y
K Q Y J R A X L O A E X J I T K S T V L G
T Z G A L L E R I E S W P N I B R G N W A
V S O S Q E F S K Y E R O I X A J O O C O
D P N O S S T K P I S B Y M B Q D L J A I
I B O N M U U R N N B T S S S A D K D D W
O L F W O S D K O I I Y U B E G R O U P S
W E D D E O L T R L E T V R W C C V N C L
O H N B Y R T I I B A Z O O Q Y J Q Q Q T
D A Z V C U P B D T P P E T O J P E G J E
H T N J B T I O S E F S C E I U W Q P T M
Z L J W S T Q R I G R B L Z Q T R T D H P
F X E F A X A R P N G U T I T Y L Z F E L
K I P P L B R H E H T N P Q D B Z E L M A
V N M J T W W C D E V E L O P E R M B E T
L O G I I H D V E C S T D B Y U P I F A E
C J L M M F E R F C O N T E X T U A L K R
W P G Y O S O K Z M Y Z C U V M V W N H R
S Q U I C K A C C E S S T O O L B A R E E
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Unit 1 Word Search Clues  

ANSWER KEY CLUE 
 Ensure your presentation works well on different devices and software 

versions.  
 These tabs appear in the Ribbon when certain objects or elements (e.g., 

charts) are selected.   
 This tab provides advanced tools and features for creating interactive and 

customized presentations.  
 Small icon or button within a group in the Ribbon, represented by a small 

arrow or ellipsis.  
 Visual displays within the Ribbon that present different options or styles in a 

graphical format.  
 Within the Ribbon, clusters of related commands and tools with a specific 

function or purpose.  
 Make copies of your presentation with several slides on each page to 

distribute to others.  
 A standard image file format used for photographs and realistic images.  
 This pane displays thumbnail images and helps to organize slides and move 

through a presentation.  
 A file format used for sharing and distributing documents.  
 A common image file format that supports lossless compression.  
 A computer program that helps you make presentations.  
 Positioned above or below the Ribbon, it offers frequently used commands 

that you can add or remove.  
 Use this feature to share presentations with others to view only and not make 

changes in the file.  
 The main control center providing navigation and execution, giving access to 

commands, tools, features and functions through groups. 
 The main workspace where you view and edit the selected slide.  
 Drag left or right to adjust the size of the Slide Navigation or Outline View 

pane.  
 Shows presentation information (e.g., the total number of slides) and includes 

buttons for Notes and various viewing options.  
 A pre-designed and formatted file that serves as a starting point for creating 

new presentations.  
 A predefined set of design elements and formatting styles that determine the 

overall appearance and visual consistency.   
 At the top of the window, it displays the name of the open presentation.  
 Allows switching between different views of the presentation, such as Slide 

Sorter.  
 Enables focus adjustments to your slides by using the - and + buttons.  
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Unit 1 Word Search with Clues Answer Key 
ANSWER KEY CLUE 

COMPATIBILITY  Ensure your presentation works well on different devices and software 
versions.  

CONTEXTUAL These tabs appear in the Ribbon when certain objects or elements (e.g., 
charts) are selected.   

DEVELOPER This tab provides advanced tools and features for creating interactive and 
customized presentations.  

DIALOG BOX LAUNCHER  Small icon or button within a group in the Ribbon, represented by a small 
arrow or ellipsis.  

GALLERIES  Visual displays within the Ribbon that present different options or styles in 
a graphical format.  

GROUPS  Within the Ribbon, clusters of related commands and tools with a specific 
function or purpose.  

HANDOUTS  Make copies of your presentation with several slides on each page to 
distribute to others.  

JPEG  Joint Photographic Experts Group, a standard image file format used for 
photographs and realistic images.  

NAVIGATION This pane displays thumbnail images and helps to organize slides and 
move through a presentation.  

PDF  Portable Document Format, a file format used for sharing and distributing 
documents.  

PNG  Portable Network Graphics, a common image file format that supports 
lossless compression.  

POWERPOINT  A computer program that helps you make presentations.  
QUICK ACCESS 
TOOLBAR  

Positioned above or below the Ribbon, it offers frequently used commands 
that you can add or remove.  

READ ONLY  Use this feature to share presentations with others to view only and not 
make changes in the file.  

RIBBON TAB The main control center providing navigation and execution, giving access 
to commands, tools, features and functions through groups. 

SLIDE PANE  The main workspace where you view and edit the selected slide.  

SPLIT BAR  Drag left or right to adjust the size of the Slide Navigation or Outline View 
pane.  

STATUS BAR  Shows presentation information (e.g., the total number of slides) and 
includes buttons for Notes and various viewing options.  

TEMPLATE  A pre-designed and formatted file that serves as a starting point for 
creating new presentations.  

THEME  A predefined set of design elements and formatting styles that determine 
the overall appearance and visual consistency.   

TITLE BAR  At the top of the window, it displays the name of the open presentation.  

VIEW BUTTONS  Allows switching between different views of the presentation, such as Slide 
Sorter.  

ZOOM SLIDER  Enables focus adjustments to your slides by using the - and + buttons.  
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Unit 1: Unplugged Activity 
 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answer with key terms from the unit.  An answer 
key is provided. 
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Unit 1 Crossword Puzzle 
 
Use the clues to solve the crossword puzzle. 
 

 
 
  

1 2 3 4 5

6 7

8

9 10 11

12 13

14

15

16 17

18 19 20

21

22

23
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Unit 1 Crossword Clues 
 
Across 

 1 Small icon or button within a group in the Ribbon, represented by a small arrow or ellipsis.  (17) 

 6 Make copies of your presentation with several slides on each page to distribute to others.  (8) 

 7 A predefined set of design elements and formatting styles that determine the overall appearance and 
visual consistency.   (5) 

 8 The main workspace where you view and edit the selected slide.  (9) 

 11 This pane displays thumbnail images and helps to organize slides and move through a presentation.  (10) 

 12 Visual displays within the Ribbon that present different options or styles in a graphical format.  (9) 

 14 A standard image file format used for photographs and realistic images.  (4) 

 16 Positioned above or below the Ribbon, it offers frequently used commands that you can add or 
remove.  (18) 

 18 Shows presentation information (e.g., the total number of slides) and includes buttons for Notes and 
various viewing options.  (9) 

 21 These tabs appear in the Ribbon when certain objects or elements (e.g., charts) are selected.   (10) 

 22 A file format used for sharing and distributing documents.  (3) 

 23 Drag left or right to adjust the size of the Slide Navigation or Outline View pane.  (8) 

 

Down 

 2 Within the Ribbon, clusters of related commands and tools with a specific function or purpose.  (6) 

 3 Ensure your presentation works well on different devices and software versions.  (13) 

 4 The main control center providing navigation and execution, giving access to commands, tools, features 
and functions through groups. (9) 

 5 A computer program that helps you make presentations.  (10) 

 9 A common image file format that supports lossless compression.  (3) 

 10 Allows switching between different views of the presentation, such as Slide Sorter.  (11) 

 13 This tab provides advanced tools and features for creating interactive and customized presentations.  (9) 

 15 Enables focus adjustments to your slides by using the - and + buttons.  (10) 

 17 Use this feature to share presentations with others to view only and not make changes in the file.  (8) 

 19 A pre-designed and formatted file that serves as a starting point for creating new presentations.  (8) 

 20 At the top of the window, it displays the name of the open presentation.  (8) 
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Unit 1 Crossword Puzzle Answer Key 
 

 
 
 

Across: 1 DIALOGBOXLAUNCHER, 6 HANDOUTS, 7 THEME, 8 SLIDEPANE, 11 NAVIGATION, 12 GALLERIES, 
14 JPEG, 16 QUICKACCESSTOOLBAR, 18 STATUSBAR, 21 CONTEXTUAL, 22 PDF, 23 SPLITBAR.  

 

Down: 2 GROUPS, 3 COMPATIBILITY, 4 RIBBONTAB, 5 POWERPOINT, 9 PNG, 10 VIEWBUTTONS, 
13 DEVELOPER, 15 ZOOMSLIDER, 17 READONLY, 19 TEMPLATE, 20 TITLEBAR. 
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Unit 1: Unplugged Activity 
 

Activity 3: Presentation Properties Sorting 
Objective: To help learners understand and categorize different presentation properties in 
PowerPoint. 

Materials:  

• Cards or paper squares, each labeled with a presentation property (e.g., Set as Read-Only, 
Password Protect, Compatibility). 

Instructions: 

• Before the activity, prepare cards or paper squares, each labeled with one of the presentation 
properties. You can use different colors or symbols to represent various categories. 

• Divide the class into small groups or pairs, depending on your class size. 
• Distribute the cards or paper squares randomly, ensuring each group receives a mix of 

properties. 
• Instruct each group to categorize the properties into three groups: "Security Features," "File 

Options," and "Presentation Inspection." 
• Encourage learners to discuss and justify why they placed each property in a particular 

category. 
• After a set time (e.g., 10 minutes), have each group share their categorization and reasoning 

with the class. 
• Facilitate a class discussion about the correct categorization of these properties and explain 

their respective functions and purposes in PowerPoint. 

Example Presentation Cards 

Set as Read-Only 
Password Protect 
Mark as Final 
Compatibility 
Inspect a Presentation 
Document Properties 
Encrypt with Password 
Optimize for Compatibility 
Personal Information Removal 
Metadata Removal 
Mark as Final with Comments 
Digital Signatures 
Document Inspector 
Accessibility Checker 
Protect Presentation for Sharing 
Restrict Permissions 
Permission Password 
Digital Rights Management (DRM) 
Redact Personal Information 
Manage Document Properties 
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Unit 1: Unplugged Activity 
 

Activity 4: Ribbon Tab Sequencing 
Objective: To help learners understand the organization of Ribbon Tabs in PowerPoint. 

Materials: Colored cards or paper strips, each representing a Ribbon Tab in PowerPoint (e.g., Home, 
Insert, Design, Transitions). 

Instructions: 

• Before the activity, prepare colored cards or paper strips, each labeled with the name of a 
Ribbon Tab in PowerPoint. For example, use red for "Home," blue for "Insert," and so on. 

• Distribute these cards or paper strips randomly to the learners. Ensure that each learner or 
group has one. 

• Instruct learners to stand in a circle, holding their assigned Ribbon Tab card. 
• Explain that their task is to arrange themselves in the correct sequence as they appear in the 

PowerPoint Ribbon. They should do this without speaking and by coordinating visually with 
their peers. 

• Allow learners to move around and collaborate to find their proper position in the Ribbon 
sequence. 

• Once they believe they are in the correct order, discuss as a group and make adjustments if 
needed. 

• Reinforce the concept of the Ribbon Tabs, their order, and the functions they contain. 
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PowerPoint Course Key Terms 
Term Definition 

3D Models Help in presenting complex structures, concepts, and designs in a more 
understandable manner. 

Adjust Pictures It includes moving, resizing, rotating, and cropping features. 

Adjust Shapes Adjusting shapes involves changing the size, position, and appearance of 
the shape. 

Align Shapes It involves arranging and positioning shapes on slides. 

Align Text 
Vertically 

Refers to positioning the text at the top, middle, or bottom of the box. 

Alignment Tools These tools help to achieve consistent, balanced, and visually appealing 
layouts. 

Alt Text A written description of an image’s content and function, helping people 
who are visually impaired to understand the meaning conveyed by the 
image. 

Animations These are visual effects that add movement and interactivity to objects. 

Annotations These are notes, comments, or remarks added to a document. 

Antonyms Words that have the opposite meaning to the selected word. 

Arrange Shapes Arranging shapes allows you to change or control the shape’s position on 
the slide. 

Auditory Cues These are signals used to convey information. 

Autocorrect Settings that allow you to automatically correct common spelling 
mistakes, typos, and formatting errors as you enter words. 

Built-in It refers to something that is an integral part of a system. 

Bullets Little symbols that appear next to each point in a list, making it clear and 
organized. 

Change Chart Change the chart type to display your data in different ways. 

Change Text Case Switch between uppercase, lowercase, sentence case, or other 
capitalization styles to help emphasize certain words or make the text 
clearer to read. 

Chart Elements These are different parts of a chart that provide extra information. 

Charts Charts are visual representations of data that help organize and display 
information. 

Clear Formatting Eliminates any unwanted styling and ensures a cohesive and consistent 
design for your slides. 
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Clipboard A feature that allows you to temporarily store and manage copied or cut 
content. 

Collaboration It is a process in which individuals or groups work together to achieve a 
common goal. 

Columns Refer to the division of a slide into multiple vertical sections, allowing you 
to organize and present your content in a structured manner. 

Compatibility Ensure your presentation works well on different devices and software 
versions. 

Contextual Tabs Tabs that appear in the Ribbon when certain objects or elements, such as 
images or charts, are selected.  

Convert Shapes Users can convert a shape to a different type without losing any 
formatting. 

Copyright © The © symbol indicates ownership and exclusive rights to creative works, 
protecting them from unauthorized use or reproduction. 

Crop Pictures Eliminate unnecessary parts of an image. 

Custom Shapes These shapes are created by users to meet specific design requirements. 

Custom Slide Show It involves specific slides to play in a different order. 

Custom Styles It refers to a unique set of design elements. 

Cut, Copy, Paste Essential features that allow you to move or duplicate text, images, or other 
elements within your presentation. 

Developer Tab A specialized tab in PowerPoint that provides advanced tools and features 
for creating interactive and customized presentations. 

Dialog Box 
Launcher 

A small icon or button within a group in the Ribbon, represented by a small 
arrow or ellipsis. 

Duplicate Slides Creating exact copies of slides within a presentation. 

Duration It is typically referring to the length of time. 

Effects It highlights specific key points. 

Embedding It means placing a file within a webpage. 

Explanatory 
Content 

It is designed to make complex or unfamiliar subjects more 
understandable. 

Find A feature that allows you to search for specific words or phrases within your 
presentation. 

Font Sets A collection of fonts that are designed to work well together and create a 
consistent and visually pleasing appearance for your slides. 

Format Painter Quickly apply formatting from one element of your presentation to 
another. 
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Format Paragraphs Control the layout, alignment, indentation, and spacing of your text to 
enhance readability and visual appeal. 

Format Shapes By using formatting features, users can change the shape’s color, size, and 
other properties. 

Format Text Enhances the overall appearance and feel of your presentation, making 
the text stand out, emphasizes important points, and improves readability. 

Galleries Visual displays within the Ribbon that present different options or styles in 
a graphical format. 

Grouped Shapes Move on the slide as a single entity. 

Groups Within each Ribbon tab, groups are clusters of related commands and 
tools that serve a specific function or purpose. 

Handouts Make copies of your presentation with several slides on each page to 
distribute to others. 

Hide Slides The action of concealing specific slides from a presentation. 

Highlight Text Emphasizes key information, allowing your audience to quickly identify 
and understand the most significant points. 

JPEG Joint Photographic Experts Group, a standard image file format 
commonly used for photographs and realistic images. 

Merge Cells By merging cells, you can create larger cells. 

Min/Restore/ 
Max/Close Buttons 

These buttons control the size and closure of the PowerPoint application 
window. 

Modify 3D Models Change the color, size, appearance and rotation of 3D models. 

Move Text Rearrange the order of text within each slide without affecting the slide 
order. 

Multimedia 
Experience 

It involves the use of various types of media, such as text, images, audio, 
and video, to engage an audience. 

Navigation It is the process of moving through and interacting with software, 
websites, or digital interfaces to access content. 

Navigation Pane A pane located on the left side of the PowerPoint window that displays a 
list of thumbnail images representing the slides in a presentation. 

Numbering A useful way to present information in a structured and organized manner, 
that helps to establish a sequential order and hierarchy within your 
content. 

Outline Pane Provides a structured view of your presentation's text, allowing you to 
reposition paragraphs, sentences, or individual words. 

Paragraph Dialog 
Launcher 

A tool that provides additional more advanced settings and fine-tune the 
appearance of your text when formatting paragraphs. 
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Paste Special A powerful feature that provides additional options for pasting content 
from the clipboard. 

PDF Portable Document Format, a file format commonly used for sharing and 
distributing documents, including presentations. 

Picture Align Select the align button to Align the selected picture horizontally and 
vertically. 

Picture Order The order button lets you bring pictures forward or send them backward. 

Pictures A visual representation of ideas, concepts, and data. 

PNG Portable Network Graphics, a common image file format that supports 
lossless compression. 

PowerPoint A computer program that helps you make presentations. 

PowerPoint Shows Allow you to organize content into visual slides. 

Preset Animations These are pre-designed animation effects. 

Promote and 
Demote Lists 

Shows how ideas are connected and more organized to help your 
audience understand the relationship between different points. 

Quick Access 
Toolbar 

Positioned above or below the Ribbon, it offers quick access to frequently 
used commands, and you can customize it to add or remove commands 
according to your preference. 

Quick Styles Collection of pre-designed formatting options. 

Read-only Use this feature to share presentations with others to view only and not 
make changes in the file. 

Rearrange Slide Changing the order or sequence of slides within a presentation. 

Registered 
Trademark ® 

The ® symbol signifies that a word, phrase, logo, or design has been 
officially registered as a trademark, providing legal protection against 
unauthorized use or imitation. 

Rehearsing It is the act of practicing. 

Replace A feature that allows you to find specific words or phrases and replace 
them with different ones throughout your presentation. 

Resize Pictures It ensures that the pictures are not stretched. 

Reuse Slides Inserting slides from one presentation into another for reuse. 

Ribbon The main interface in PowerPoint that provides access to commands 
categorized into groups for clear navigation and execution. 

Ribbon Tab The interface at the top of the window that includes tabs and groups to 
organize a range of commands and tools, serving as the main control 
center to access different features and functions within the application. 

Screenshots And 
Screen Clippings 

Capture and insert images of specific content. 
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Shading Adding a background color or pattern to cells or an entire table. 

Shape Styles They consist of preset colors and effects that change the appearance of 
your text boxes and shapes. 

Shapes These can be different things like rectangles, circles, or arrows that you can 
use to display information. 

Simultaneously It means doing two or more things at the exact same time. 

Slide Background The visual elements behind the content on a slide. 

Slide Layout Templates for arranging content and design elements on slides. 

Slide Master A master template for consistent formatting across all slides. 

Slide Navigation 
Pane 

It displays thumbnail views of each slide, helping you organize and 
navigate through slides in your presentation. 

Slide Pane This is the main workspace where you view and edit the selected slide. 

Slide Sections Dividing a presentation into segments for organization. 

Slide Size The dimensions and shape of individual slides in a presentation. 

Slides Pane The panel displaying slide thumbnails for easy navigation. 

SmartArt Create visually appealing diagrams and graphics. 

Special Characters Symbols or icons that you can't find on your regular keyboard and can help  
emphasize ideas, add creativity, and make slides more interesting. 

Spell Check A useful tool that helps you identify and correct spelling errors in your 
presentation. 

Spell Check 
Options 

Customize and control how the Spell Check feature works. 

Split Bar By dragging this bar left or right, you can adjust the size of the Slide 
Navigation or Outline View pane. 

Split Cells By splitting cells, you can divide a single cell into multiple smaller cells. 

Status Bar It shows presentation information, such as the current slide number and 
total number of slides, and includes buttons for Notes and various viewing 
options. 

Synonyms Words with a similar meaning to the selected word. 

Table Borders Table borders refer to the lines surrounding the cells in a table. 

Table Shading Shading in a table refers to adding a background color to the cells. 

Table Styles Table styles consist of combinations of colors, borders, shading, and font 
formatting that can be applied to tables. 

Tables Tables have rows and columns that create a grid-like structure. 

Tabs Setting tabs refers to defining the precise positions where the text aligns 
within a text box or placeholder. 

59



Template A pre-designed and formatted file that serves as a starting point for 
creating new presentations. 

Text Alignment Refers to the positioning of text within a text box or placeholder to 
determine how the text is horizontally aligned, whether it's aligned to the 
left, center, right, or justified. 

Text Color Helps create contrast, highlight important information, or match the color 
scheme of your presentation. 

Text Direction Refers to the orientation or angle at which the text appears on a slide. It 
determines whether the text is displayed horizontally or vertically. 

Text Effects Add visual enhancements to your text, making it more captivating and 
engaging for your audience. 

Theme A predefined set of design elements and formatting styles that determine 
the overall appearance and visual consistency of a presentation.  

Themes Design packages that provide consistent colors, fonts, and styles. 

Thesaurus A valuable tool for finding synonyms, antonyms, and related words to 
enhance the variety and richness of your vocabulary. 

Title Bar Located at the top of the window, it displays the name of the open 
presentation. 

Trademark ™ The ™ symbol indicates that a word, phrase, logo, or design is being used 
as a trademark, although it may not have official registration, still offering 
some level of legal recognition and protection. 

Transitions Transition effects occur when you move from one slide to another. 

Trim It is the process of cutting or removing specific parts of a video to shorten 
its duration. 

Versatile  It refers to a flexible or adaptable method or approach that can be applied 
in various situations. 

Video Dimensions It refers to the physical size of a video in terms of its width and height. 

View Buttons These buttons allow you to switch between different views of your 
presentation, such as Normal, Slide Sorter, Reading, and Slide Show. 

Webpage It is a document on the internet. 

Word Document 
Outlines 

A Word document that can be imported onto a PowerPoint slide to save 
time and effort when creating presentations. 

WordArt Create stylized and decorative text. 

Zoom Slider Positioned on the status bar, it enables you to adjust the zoom level of your 
slides, either by using the minus and plus buttons or by dragging the slider. 
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